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Audience

Preface

Using Oracle Sales Cloud Adapter describes how to use the Oracle Sales Cloud adapter
in your SOA composite applications and Oracle Service Bus business services.

Topics:

e Audience

* Documentation Accessibility
e Related Resources

e Conventions

Using Oracle Sales Cloud Adapter is intended for users who want to create, deploy, test,
and monitor applications that use the Oracle Sales Cloud adapter.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at ht t p: / / www. or acl e. conl pl s/t opi ¢/ | ookup?
ct x=acc& d=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit ht t p: / / www. or acl e. conl pl s/
t opi ¢/ | ookup?ct x=acc& d=i nf o orvisithtt p: // www. or acl e. conl pl s/

t opi ¢/ | ookup?ct x=accé& d=t r s if you are hearing impaired.

Related Resources

For more information, see these Oracle resources:

* Developing SOA Applications with Oracle SOA Suite

o Administering Oracle SOA Suite and Oracle Business Process Management Suite
* Administering Oracle Service Bus

* Understanding Technology Adapters


http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
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Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated

with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

nonospace Monospace type indicates commands within a paragraph, URLs, code

in examples, text that appears on the screen, or text that you enter.
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Introduction to Oracle Sales Cloud Adapter

This section introduces Oracle Sales Cloud adapter.

Topics

* Oracle Sales Cloud

¢ Installing the Cloud Adapters

¢ Performing Postinstallation Configuration Tasks
e Specifying the Oracle Sales Cloud WSDL

® Obtaining the Authentication Credentials

e Unsupported Features

e Restrictions

Oracle Sales Cloud

Oracle Sales Cloud enables modern selling with tools that are easy to deploy and use,
completely mobile, packed with powerful analytics, and built for collaborative selling
and revenue generation. Oracle Sales Cloud includes a set of features for creating and
tracking sales campaigns, developing leads into business opportunities, and pursuing
opportunities to generate revenue. Sales accounts, leads, and opportunities can be
automatically assigned to territories and sales teams.

The Oracle Sales Cloud adapter enables customers to easily integrate their on-premises
or SaaS applications with Oracle Sales Cloud without having to know the specific
details involved in the integration.

Integration with Oracle Fusion Applications may involve several design-time and
runtime considerations that require users to manually build and manage additional
logic into their integration for authentication, session management, fault handling,
data transformation mappings, and so on. The Oracle Sales Cloud adapter reduces the
cost of building and maintaining this complex logic with out-of-the-box features such
as a graphical, point-and-click, wizard-based designer. The Oracle Sales Cloud
connection:

¢ Interacts at runtime with the publicly-exposed Oracle Sales Cloud business objects
to perform operations defined on them.

* Provides contextual information to the developer at design time about the business
objects and services available for integration.

* Provides custom objects, both standalone and child, that are referenced indirectly
in the Oracle Sales Cloud service WSDL. These objects are presented as first-class,
strongly-typed objects.
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Installing the Cloud Adapters

For more information, see Configuring Oracle Sales Cloud Properties.

Installing the Cloud Adapters

See the README. t xt available with the patch for instructions on installing the cloud

adapters.

After you complete adapter installation, perform the tasks described in Performing

Postinstallation Configuration Tasks.

Note: For information about supported versions and platforms, see the
release certification matrix at Supported System Configurations.

Performing Postinstallation Configuration Tasks

You must perform postinstallation configuration tasks after installing the cloud

adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud

Adapters Postinstallation Configuration Guide.

Specifying the Oracle Sales Cloud Service Catalog Service WSDL

You must specify a mandatory Oracle Sales Cloud service catalog service WSDL for

accessing business objects.

A mandatory Oracle Sales Cloud service catalog service WSDL is required for
accessing business objects. The service catalog service WSDL is required to configure
the adapter for both inbound and outbound endpoints using either business objects or

business services.

Obtaining the Service Catalog Service WSDL

WSDL Requirements

Where Do You Get the WSDL?

The URL must be that of a service catalog
service WSDL. The service catalog service is a
Fusion Application service that returns a list
of external services available for integration.
It allows clients to retrieve information about
all public Fusion Application service
endpoints available for that instance.

The service catalog service enables clients to
retrieve information about all public Oracle
Fusion Application service endpoints
available for that instance. The information it
returns is specific to the particular cloud
instance and also reflects the new services
that may have been introduced in patches
applied to the instance. This service is used to
programmatically discover the SOAP services
available on the cloud instance and retrieve
the necessary metadata to invoke the SOAP
services to manage business objects.

The developer creating an Oracle Sales Cloud
connection must work with the Oracle Sales
Cloud service administrator to get the
concrete WSDL URL for the service catalog
service provisioned for the specific SaaS
application. Instructions for deriving the URL
for the service catalog service, which is done
manually, are documented in Getting Started
with Web Services.
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Specifying the Oracle Sales Cloud Service Catalog Service WSDL

This section describes how to derive the external virtual host and port for a tokenized
service catalog service WSDL. The topology information in the Topology Registration
setup task contains the external virtual host and port for the domains and applications.
The following instructions describe the steps for deriving the values using the service
catalog service WSDL URL as an example: htt ps: // atf _server: port/

f ndAppCor eSer vi ces/ Ser vi ceCat al ogSer vi ce.

To access the Review Topology page, the
ASM_REVIEW_TOPOLOGY_HIERARCHY_PRIV entitlement must be granted to the
user’s job role. The entitlement is granted to the
ASM_APPLICATION_DEPLOYER_DUTY duty role, which is inherited by the duty
roles ASM_APPLICATION_DEVELOPER_DUTY and
ASM_APPLICATION_ADMIN_DUTY.

If the menu items and tasks described in the following procedure are not available in
your cloud instance, your user account is missing the required role. Contact your
cloud instance security administrator for assistance.

1. Login to the cloud instance.

2. Click the Navigator icon in the global area in the top part of the window, then
chose Setup and Maintenance under the Tools heading.

3. Select Review Topology under the Topology Registration section in the Tasks
regional area on the left side of the window.

4. Click the Detailed tab in the middle of the window.

The tab shows the list of domains configured in the cloud instance.

ORACLE # ® K | ¥ ¢ @ | APPLICATION IMPLEMENTATION CONSULTANT> (O

Setup and Maintenance
| Tasks

Review Topology Dane
Implementations
« Getting Started Summary  Detailed = Diagnostic Tests
+ Configure Offerings e
« Manage Implementaton Projects View v Format + Freeze  EfiDetach &l Wrap Download Domain Connections »
Setip Dats Bxport and Import Mame External Server Host External Server Port ETPSPrise ContextRoot

= Manage Configuration Packages Environment

o Manage Export and Import Processes »» OSNDomain
Implementation Objects (> SCMDomain

. B & ProjectsComain
+ Manage Offerings and Functional Areas N
« Manage Features & ProcurementDomain

« Manage Business Processes & MigrationDomair

s Manage Task Lists and Tasks &» IDMDomain

» Manage Business Objects & ICDomain
Topology Objects &> HCMDomain

+ Manage Domains » FinancialDomain

+ Manage Enterprise Applications 7% CommonDomain

« Manage Third Party Applications » CRMDomain

+ Manage Modules
+ Manage Compasites

Topology Registration
* Review Topology 9

i» BIDomain

Search: Tasks

Search

Advanced
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Obtaining the Authentication Credentials

5.

Map the token name for the service path value to the domain name in the

Topology Manager:

Token Name in Service Path

Domain Name

atf_server
crm_server
fin_server
hem_server
ic_server
prec_server
prj_server

scm_server

CommonDomain
CRMDomain
FinancialDomain
HCMDomain

ICDomain

ProcurementDomain

ProjectsDomain

SCMDomain

Expand the domain name and select any external virtual host and port for the
J2EE applications that are deployed on the domain. In the sample window, the
values for this particular instance are fs-your-cloud-hostname and 443,

respectively.

ORACLE’

Setup and Maintenance
| Tasks

Implementations

s Getting Started

« Configure Offerings

* Manage Implementation Projects
Setup Data Export and Import

* Manage Configuration Packages

+ Manage Export and Import Processes
Implementation Objects

s Manage Offerings and Functional Areas

» Manage Features

+ Manage Business Processes

* Manage Task Lists and Tasks

» Manage Business Cbjects
Topology Objects

« Manage Domains
Manage Enterprise Applications
Manage Third Party Applications
Manage Modules

.
.
.
* Manage Composites

Topelogy Registration
» Review Topology 4

| Search: Tasks

Search

Advanced

Summary

View » Format -

Name

o @ Y | ¥ & @ | APPLICATION IMPLEMENTATION_CONSULTANT~ O

Review Topology

Detailed = Diagnostic Tests

{ll] Freeze a‘Detach \;J Wrap

External Server Host

i» Image Process Management

& Inbound Refinery

& Zms Stock Quote

& Zms Rss Feed

B WLM

& TopologyManagerService

& Setup Web Services Policy Mai

i Setup-S0A

i» Setup-ESS

»» Setup Diagnostic Dashboard

> Setup

& Security Token Service

i» Search ESS

& ST Conference

% PJGP6 Primavera Application

& Oracle University

» Oracle Portal Home

& Orade Fusion Applications Tec

Applications Core Setup

fndwebServices L@
fndSetup
fndappCoreServices

& Oracle Fusion Applications For

& Oracle Documentation Portal

& My Orade Support Communitie

f3-youreioud-f

fs-your<lo

fs-yourciou

Dawnload Domain Connections

External
Server

443

Enter|
Envirc
or...
or
or...
or

ar...
or..
or..
or

or..
ar...

or...
or
or..
or
or..

ar

ar...
or..
or.

Done

Context Roat

fndwebServices
fndSetup
fndAppCoreservices

Replace the domai nNanme_ser ver : Port Nunber with the external virtual host
and port identified in the previous step. For example:

https://fs-your-cl oud- host nane: port/fndAppCor eServi ces/
Ser vi ceCat al ogSer vi ce?wsdl

Obtaining the Authentication Credentials

Obtain the user name and password that are required for creating the Credential Store
Framework (CSF) authentication key in Oracle JDeveloper and Oracle Enterprise
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Unsupported Features

Manager Fusion Middleware Control from your SOA domain administrator. These
credentials are required for most cloud adapters. For the Oracle Eloqua Cloud adapter,
the credentials require three properties (company, username, and password).

Unsupported Features

The adapter does not support the following features:

Restrictions

Adapter runtime retry configuration properties such asj ca. retry. count,
jca.retry. backoff,jca.retry.interval ,andjca.retry. maxinterval.

Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion
Middleware Control.

The display of properties in the Properties tab for a reference (outbound) adapter
in Oracle Enterprise Manager Fusion Middleware Control (for example, service
WSDL URL, CSF key used, and others). These are the reference adapters that you
select on the Services and References page.

Rejected message handling

The following message encryption and decryption features available when you
right-click a cloud adapter in the Exposed Service swimlane or External
References swimlane in Oracle JDeveloper:

— DProtect Sensitive Data > Encrypt Request Data for cloud adapters in the
Exposed Service swimlane.

— Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the
External References swimlane.

The policy attachments feature available when you right-click a cloud adapter in
the Exposed Service swimlane or External References swimlane in Oracle
JDeveloper.

Note the following restrictions:

Not all Oracle Fusion Application services are available in SaaS mode because the
Oracle Fusion Application topology splits visibility to web and service resources into
two categories: internal and external. Therefore, some services are internal and cannot
be used by the adapter for integration. Only external services are available for public
consumption.

The adapter cannot be used for integrating the interfamily modules, because services
defined on them are not external services.
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Restrictions
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Understanding Oracle Sales Cloud Adapter
Features

The Oracle Sales Cloud adapter provides the following features.

Topics

* Adapter Architecture

* Custom Business Objects

¢ Understanding Oracle Sales Cloud Adapter Design Integration Patterns
¢ Designing an Integration with the Adapter Configuration Wizard

* Monitoring Your Application During Runtime

Adapter Architecture

The adapter includes the following key features.
Service Catalog Service

The WSDL URL that you specify during adapter configuration must be that of a
service catalog service WSDL. The service catalog service is a Fusion Application
service that returns a list of external services available for integration. The service
catalog service provides the following features:

e Provisioned on the cloud instance.

* Provides public external service information for the specific cloud instance. It
reflects new services introduced in patches and customizations.

* Gets the endpoint and metadata for public external services on the cloud instance
on which the service catalog service is provisioned. The information that it returns
is specific to the particular cloud instance and reflects new services that may have
been introduced in patches applied to the instance. Oracle Fusion Applications in
the Oracle Applications cloud enable partners and customers to use this service to
programmatically discover the SOAP services available on the cloud instance and
retrieve the necessary metadata to invoke the SOAP services to manage business
objects.

Business Objects

The business object that the service implements is composed of a hierarchy of logical
entities that contain a collection of attributes. As an example, the opportunity service is
defined on the opportunity business object. The opportunity business object consists of
many entities such as an opportunity contact and opportunity lead. The business
object is the functional object on which the service operates. Examples include
opportunity, sales account, sales lead, marketing campaign, and sales forecast.
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Adapter Architecture

Business Object Notation

The business objects are grouped into related objects that are in turn grouped into
higher-level related objects. For example, the opportunity service business object
contains the following value:

¢ CRM: Opportunity Management : Opportunity

The above value means the service operates on the opportunity object. The
opportunity object is grouped into a related set of objects called opportunity
management that in turn is grouped into a larger set of related objects called CRM
(Customer Relationship Management). Other business objects included in the
opportunity management grouping are sales method and sales revenue. Other logical
business object groups in CRM are lead management and partner management.

Life Cycle of Business Object Services

The business object service goes through three life cycle phases:

e Active: This phase starts when the service is first delivered and lasts until it is
deprecated.

® Deprecated: A service may be deprecated when it is superseded by a newer version
of the service or there is a planned obsolescence in a future release. The deprecated
status means that the service is still supported, but becomes obsolete in a later
release.

Deprecated services do not mean they are not supported. They continue to be
supported until they become obsolete. Deprecated services must go through the
deprecation cycle during which users are told that the service is going to be
withdrawn at a future time. However, it is still a service that must be supported.

If a selected business object or service has a life cycle value of deprecated, a
warning message is displayed. If the business object or service captures
information about a replacement business object or service, then it may also be
displayed. This information comes from the annotation element in the service’s
WSDL.

A portion of a service WSDL is shown below.

<wsdl : docunent ation xm ns: oer="http://xm ns. oracl e. conf oer">

<name>Cpportunity Service</name>

<description>A service to create, update, get, find, or delete opportunities.
WARNI NG This service will be deprecated and replaced with a newer version in

the upconing rel ease. </ descri ption>

<oer:|ifecycl e>Active</oer:|ifecycle>

<oer: conpati bility>Supported - Backward Conpatibility Assured</oer:conmpatibility>

<oer: category nanme="|bo">

<val ue>CRM CRM :  MOO- Cpportunity Management : MOO_OPPORTUNI TY- Cpportunity</val ue>
</ oer: cat egory>

</wsdl : docunent at i on>

New service consumers should consume the newer active version of the service
and existing customers should migrate to the newer active version of the service.

® Obsolete: The service is no longer shipped or supported.
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Custom Business Objects

Supportability

The public external SOAP services are supported throughout their life cycle until they
are obsolete. Conversely, services that are considered private and not intended for
partners and customers to consume are not supported.

Cloud Services

The cloud web services (for example, for Oracle Sales Cloud or Oracle HCM Cloud)
provide access to an application programming interface (API) that companies can use
to build programs to integrate with the cloud (for example, Oracle Sales Cloud or
Oracle HCM Cloud). The API consists of a set of WSDL files that describes the
interface to the cloud objects. This provides a programmatic interface for accessing
cloud information (for example, for Oracle Sales Cloud or Oracle HCM Cloud). A
customer application can use the WSDL files through standard web services
development tools. The web services API allows companies to build programs to
integrate with the cloud (for example, Oracle Sales Cloud or Oracle HCM Cloud).

Some common examples of client integrations include integrations of CRM and back-
office applications. You can retrieve real-time sales and marketing information from
the cloud (for example, Oracle Sales Cloud or Oracle HCM Cloud) and use it in
financial and other back-office applications. For example, you can retrieve information
about recently closed opportunities through the web services interface and insert this
information into an order entry system that has a web services user interface. In
addition, you can store information from back-office applications for instant access by
users, which is visible in custom fields.

Security

Prior to accessing the fusion web services, user credentials must be supplied in
compliance with the security policies attached to the cloud services (for example,
Oracle Sales Cloud or Oracle HCM Cloud). Upon successful authentication, the user is
logged in and can issue web service requests to access and retrieve data. All cloud web
services are stateless (for example, Oracle Sales Cloud or Oracle HCM Cloud) such
that each web service call is an atomic transaction and is not associated to a persistent
session. Management of the stateless web service calls is handled by the underlying
fusion framework and is abstracted from the end user.

Custom Business Objects

The adapter includes support for custom business objects.

Custom objects are similar to user-defined objects, which are added by the user in the
deployed instance.

Custom objects and custom attributes have "_c" appended to their names. Custom
objects are exposed using a generic service interface. The custom object web service
contains generic operations to which the custom object is passed as a parameter.
Examining the schema that is referenced by the service WSDL shows the details of the
parameters of the available operations.
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Understanding Oracle Sales Cloud Adapter Design Integration Patterns

Understanding Oracle Sales Cloud Adapter Design Integration Patterns

Oracle Sales Cloud adapter supports the following design integration patterns in the
Adapter Configuration Wizard.

Outbound Integration from Oracle Sales Cloud Adapter into the Oracle Sales
Cloud Application

* You configure the Oracle Sales Cloud adapter to connect to the Oracle Sales Cloud
application.

* You navigate through the set of available business objects (standard and custom)
and select an operation to invoke the object. You can also use the search facility to
locate a business object.

* You save the adapter configuration and exit the Adapter Configuration Wizard.

* You map the application business object with the logical business object of Oracle
Sales Cloud.

* You complete the design of the SOA composite application.

At runtime, the SOA composite application performs the selected operation on the
business object on Oracle Sales Cloud using the Oracle Sales Cloud adapter.

Inbound Integration into Oracle Sales Cloud Adapter from the Oracle Sales
Cloud Application

The Oracle Sales Cloud adapter can also be configured for inbound connectivity. For
example, you may want to integrate an on-premise application with the Oracle Sales
Cloud application by defining an inbound service interface using the Oracle Sales
Cloud adapter. This service is then invoked by Oracle Sales Cloud.

* You define an inbound service interface to be invoked by Oracle Sales Cloud.

* You configure a service endpoint by browsing through a list of objects. You select
the business object to receive from Oracle Sales Cloud as a request payload to this
SOA composite application.

* You complete the Oracle Sales Cloud adapter configuration.

* You complete the design of the SOA composite application as per the business
requirements.

Designing an Integration with the Adapter Configuration Wizard

You use the Adapter Configuration Wizard to include the Oracle Sales Cloud adapter
in a SOA composite application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to
select the artifacts required to communicate with the Oracle Sales Cloud application.
You can configure the adapter in the inbound (source) direction or the outbound
(target) direction.

¢ Inbound (source) direction:

The Basic Info page prompts you to enter a meaningful name and optional
description.
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Designing an Integration with the Adapter Configuration Wizard

Cloud Wizard Test - Step 1 of 4

Welcome to Oracle Sales Cloud Connection Configuration Wizard

1 Basic Info . . . "
T || This wizard helps you create a service using Oracle Sales Cloud Connection.
¢ Connection Wou will be asked to specify configuration parameters and define an operation forthe service.
) Operatians
Summar
“hat do you want ta call yeur connection?®
|Dserererence
What does this connection do?
Help Bac Hext = Eimist Cancel

The Connection page prompts you to specify the WSDL, security policy (username
password token), and CSF authentication key to use. The authentication key is
created by clicking the Add icon to specify the key name, user name, and
password. You must also specify these same CSF authentication key values in
Oracle Enterprise Manager Fusion Middleware Control. For information, see the
Oracle Cloud Adapters Postinstallation Configuration Guide.

You can also test the connection to the Oracle Sales Cloud application on the
Connection page. This enables you to confirm that the URL to the service catalog
service and credentials are correct. Status is displayed that indicates whether the
connection is successful and whether the credentials are authenticated by the
Oracle Sales Cloud application. Any errors that occurred during the attempt to
connect are also displayed.

Cloud Wizard Test - Step 2 of 4

Oracle Sales Cloud Server Connection

T fasic Infe, A Oracle Sales Cloud Cloud Server connection is required to access the operations and business objects available.
i Connection
I .
9 Dperatians § .
) @ Where can | find 1he Objects you need?
smim
"WSDL URL ork/DSCTEstApplication/Frojecil/SOA /WSDLs /ServiceCatalogService wsdl| ]
(@) Pick the key 10 get in the door
Security Policy: |USERNAME_PASSWORD_TOKEN |
“Authentication Key: [ooc o o] o 2 38
Test
Help <lack [ g Einist Cancel
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The Request page prompts you to select the business object to receive as a request
from the Oracle Sales Cloud application.

Note: When you select a business object in the inbound direction, a
description is displayed below the table, but life cycle information about the
selected object (for example, active or deprecated) is not displayed. In the
outbound direction, life cycle information for the business object is displayed.

To get all available data objects in the Oracle Sales Cloud instance, the adapter first
reads the schema document (.XSD) that is referenced in the service’s WSDL. The
adapter then parses this XSD to obtain the list of all schema imports and shows
them as data objects.

For example, the adapter displays the opportunity business object and its useful
metadata first by reading the opportunity service’s WSDL and the referenced
schema Oppor t uni t ySer vi ce. xsd file. The XSD in turns imports another
schema Oppor t uni ty. xsd in which the opportunity business object is defined.
The metadata for the opportunity business object is defined in this schema.

A search facility is provided that enables you to filter the display of business
objects for quick selection. When you enter a search string, the list renders only the
matching business objects in the list browser instead of showing all objects.

Cloud Wizard Test - Step 3 of 5

Oracle Sales Cloud Service Endpoint Operations Page

.I Define the integratoin service interface by browsing through a list of business/event objects
¥ Lonpectizn
T
td Request Select Business Object
Respons:
T st Q, Object Name Filzer
Actionfeasons
ActionReasonsTranslation
Actions
s ctionsList
ActionsTranslation
A ctivity
ActivityAssignes
Activity Category
4 ctivity Contact
Activity DeleteException
Help < Back Mext : Einist Cancel

The Response page prompts you to select the business object for the integration to
send as a response document to the Oracle Sales Cloud application. To send no
response, deselect the Send checkbox. You can also optionally select to send an
immediate response back to the Oracle Sales Cloud application. An immediate
response indicates a conversational response. For an immediate response, you can
select any of the data objects as a response document. You also can select to send
fault details with the immediate response.
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Cloud Wizard Test - Step 5 of 5

Oracle Sales Cloud Service Endpoint Configuration

Select the business object ta receive from Oracle Sales Cloud as a respanse from the integration flow. Select Immediate to provide a
nection conversational response. Select Delayed to provide an asynchranous response that can be sent later.

| Response [+ Send ke w | B [¥] Also Send Faults

Select Business Object:

Q Object Name Filter

Account
ActionReasons
ActionReasensTranslation

ActionsTranslation

Activity

ActivityAssignee

Lctivity Category

Activity Contact N

Mame : HCM @ Global Human Resource
Description : An object that

Help < Back Blext > Einist I Cancel

The Summary page displays your selections from the previous pages.

Cloud Wizard Test - Step 5 of 5

Oracle Sales Cloud Connection Artifacts Summary
ic Inif
Oracle Sales Cloud Connection corfiguration was successful.
nectior
T Request OscService
¥
|| e Summary Description:
|
|
Opsration: pracess
Request Object:  Account
Respanseé Object: AbsenceCase
Help < Back Hert Einish Cancel
®

e Qutbound (source) direction:

The Basic Info page prompts you to enter a meaningful name and optional
description. This is the same page that is displayed in the inbound direction.

The Connection page prompts you to specify the WSDL, security policy (none,
basic authentication, or username password token), and CSF authentication key to
use. This is the same page that is displayed in the inbound direction.

The Operations page prompts you to select a business object or service and the
operation to perform on your selection.

A search facility based on service names is also provided. To quickly select a
business service, you type a search string. The list renders only matching business
services in the list browser instead of showing all services.
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Cloud Wizard Test - Step 3 of 4

Oracle Sales Cloud Operation Configuration

i Basic Inf
| Select Operations and Business Objects
y  Lannestien

t "
T- Operations Browse by: EBusiness Ohjects ™

@ Summary

(3) Business Objects:

Q, object Name Filte,

CRM Extansiila Object

Customer Accaunt

File Import

HCM : AbsenceCaseService

HCM : ActiensService

HCM : AreasOfResponsibilityService

LifeCycle ; Active
Descrigtion:

Descript service for creatin ating, and retrieving accounts

Help < Back

to perform on this Ohject? igmc:onnl ']

Hext = Rk Einish Cancel

The Summary page displays your selections from the previous pages.

Cloud Wizard Test - Step 4 of §

‘ : Oracle Sales Cloud Connection configuration was successful.
<
|

DscReference

Description:

Business Object; Account

Operatian gethccount

Help

< fack

1 Einish | Cancel

The following artifacts are created for each adapter instance and displayed in the

Applications window in Oracle JDeveloper:

* WSDL file: Provides a simplified user experience in terms of

creating data

mappings, while integrating with the Oracle Sales Cloud application services. For
example, an abstract WSDL defines strongly-typed types, the name of the
operation and business object selected, and the request and response structures.

e JCA file: Contains the internal implementation details used b

y the adapter during

runtime. It contains the different interaction and connection properties used by the

adapter.
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Monitoring Your Application During Runtime

When application configuration is complete, you can deploy the application from
Oracle JDeveloper to the runtime environment.

Note: The wizard does not support the creation of response message
callbacks. As an alternative, you can design your BPEL process to include
activities that support callbacks.

For information about the details to specify in the fields of the wizard pages, see
Configuring Oracle Sales Cloud Properties.

Monitoring Your Application During Runtime

You can monitor your application from the runtime environment.

You use the runtime part of the adapter for delivering the information generated
during design time to the service endpoint. You can monitor your SOA composite
application or Oracle Service Bus business service from Oracle Enterprise Manager
Fusion Middleware Control. You can also test and monitor your Oracle Service Bus
business service from Oracle Service Bus Console.

Understanding Oracle Sales Cloud Adapter Features 2-9



Monitoring Your Application During Runtime

2-10 Using Oracle Sales Cloud Adapter



3

Designing SOA Composite Applications

This section describes how design a SOA composite application with the Oracle Sales
Cloud adapter in Oracle JDeveloper.

Topics

¢ Creating a SOA Composite Application

¢ Adding an Adapter to a SOA Composite Application as a Service or Reference

¢ Completing Design of a SOA Composite Application

Creating a SOA Composite Application

This section provides an overview of how to create a SOA composite application in
which to include the adapter as an exposed service or external reference.

1.

2.

Start Oracle JDeveloper.
From the File menu, select New > Application.

In the New Gallery dialog, select SOA Application from the Items list, then click
OK. The SOA Create SOA Application wizard is displayed.

Specify an application name, and click Next.
Specify a project name, and click Next.
Select Composite with BPEL Process, and click Finish.

The SOA composite application is displayed for designing in the SOA Composite
Editor.

Adding an Adapter to a SOA Composite Application as a Service or

Reference

You can add an Oracle Sales Cloud adapter to a SOA composite application as an
inbound (source) service to the Exposed Services swimlane or as an outbound (target)
reference to the External References swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your SOA composite application.

2. Go to the Cloud section under Custom/Third Party.

The adapters are displayed.
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3. Drag the adapter to the appropriate swimlane:

a. To create an inbound (source) service, drag the adapter to the Exposed Services
swimlane, and see the following sections that describe the wizard pages for
configuring the adapter:

¢ Configuring Basic Information Properties

¢ Configuring Oracle Cloud Adapter Connection and CSF Key Properties
¢ Configuring Oracle Sales Cloud Source Request Properties

¢ Configuring Oracle Sales Cloud Source Response Properties

¢ Reviewing Configuration Values on the Summary Page

b. To create an outbound (target) reference, drag the adapter to the External
References swimlane, and see the following sections that describe the wizard
pages for configuring the adapter.
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Completing Design of a SOA Composite Application

¢ Configuring Basic Information Properties

* Configuring Oracle Cloud Adapter Connection and CSF Key Properties
¢ Configuring Oracle Sales Cloud Target Operations Properties

* Reviewing Configuration Values on the Summary Page

Completing Design of a SOA Composite Application

This section provides an overview of how to complete design of your SOA composite
application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

a. Connect the BPEL process to the adapter. For this example, the BPEL process is
connected to the adapter as an external reference:

Exposed Services Components External Referen:
(o B !5:R£ferenne
- Eﬁ . @ Diperations
bpelprocessl_clie.. ) getAccourt
Opemtions: | -
geLheea unt |

LY B

b. Design the contents of the BPEL process. For example:
i.  Double-click the BPEL process.

ii. Add and configure an invoke activity to invoke the adapter.
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Help Apply 118 Cancel

iii. Add and configure assign activities to copy the contents of one variable to
another when sending and receiving messages to and from the adapter.
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iv. Add and configure other activities, as appropriate.
When complete, view the SOA composite application in the SOA
Composite Editor.
[:} xposed Services Components xternal References
(a3 ® @@= ) b
bpelprocessl_clie... OscReference
[Dperations: [ Operations:

gethccoun getAccount

For specific information about creating and designing SOA composite applications,
see Developing SOA Applications with Oracle SOA Suite.

. Deploy the SOA composite application:

Note: You cannot use Oracle JDeveloper to deploy a SOA composite
application to Oracle SOA Suite Cloud Service. For information about other
deployment options, see Using Oracle SOA Suite Cloud Service.

a. In the navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite
application to the application server.
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Designing Oracle Service Bus Business
Services

This section describes how to design an Oracle Service Bus business service with the
adapter in Oracle JDeveloper.

Topics

¢ Creating an Oracle Service Bus Business Service

¢ Adding an Adapter to a Business Service as a Service or Reference
¢ Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service

This section provides an overview of how to create an Oracle Service Bus business
service in which to include the adapter in Oracle JDeveloper.

1. Start Oracle JDeveloper.
2. From the File menu, select New > Application.

3. In the New Gallery dialog, select Service Bus Application from the Items list, then
click OK.

4. Specify an application name, and click Next.
5. Specify a project name.
6. Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle
Service Bus Overview Editor.

Adding an Adapter to a Business Service as a Service or Reference

You can add the adapter to an Oracle Service Bus business service as an inbound
(source) proxy service to the Proxy Services swimlane or as an outbound (target)
external service to the External Services swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your Oracle Service Bus business service.
2. Go to the Cloud section under Service Bus.

The adapters are displayed.
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3. Drag the adapter to the appropriate swimlane:

a. To create an inbound (source) proxy service, drag the adapter to the Proxy
Services swimlane, and see the following sections that describe the wizard
pages for configuring the adapter:

¢ Configuring Basic Information Properties

¢ Configuring Oracle Cloud Adapter Connection and CSF Key Properties

¢ Configuring Oracle Sales Cloud Source Request Properties

¢ Configuring Oracle Sales Cloud Source Response Configuration Properties
* Reviewing Configuration Values on the Summary Page

b. To create an outbound (target) external service, drag the adapter to the External
Services swimlane, and see the following sections that describe the wizard
pages for configuring the adapter:
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¢ Configuring Basic Information Properties
e Configuring Oracle Cloud Adapter Connection and CSF Key Properties
¢ Configuring Oracle Sales Cloud Target Operations Properties

e Reviewing Configuration Values on the Summary Page

Completing Design of an Oracle Service Bus Business Service

This section provides an overview of how to complete design of your Oracle Service
Bus business service and deploy the application.

1. Design the contents of your Oracle Service Bus business service. For example, to
configure an Oracle Service Bus proxy service in your business service:

2.

a.

In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins
lane and select Insert > Pipeline.

The Create Pipeline Service dialog is displayed.

. Enter a name for the pipeline and select the project location, then click Next

Select WSDL as the Service Type.

. To the right of the WSDL selection, click the Browse icon to select the WSDL.

Select Application.

Expand Resource Chooser and select the WSDL file, then click OK.

. Ensure that Expose as a Proxy Service is selected.

. From the Proxy Transport list, select http, then click Finish.

The Pipeline component is displayed in the Oracle Service Bus Overview
Editor.

Connect the external service to the Pipeline component.

For more information about creating and designing an Oracle Service Bus business
service, see Developing Services with Oracle Service Bus.

Open the pipeline that shows the default routing.

3. Verify the service and corresponding operation are displayed in the Routing
Properties tab at the bottom of the dialog.

The outbound project is ready for deployment.

4. Deploy the business service.

a.

b.

Select the project, then select Deploy to Service Bus Server.

Follow the steps in the deployment wizard.
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Configuring Oracle Sales Cloud Properties

The Oracle Sales Cloud adapter enables you to create integrations with an Oracle Sales
Cloud application.

The following sections describe the wizard pages that guide you through
configuration of the Oracle Sales Cloud adapter as a source and target in an
integration.

Topics

¢ Configuring Basic Information Properties

¢ Configuring Oracle Cloud Adapter Connection and CSF Key Properties

* Configuring Oracle Sales Cloud Source Request Configuration Properties
¢ Configuring Oracle Sales Cloud Source Response Configuration Properties
* Configuring Oracle Sales Cloud Target Operation Properties

¢ Reviewing Configuration Values on the Summary Page

For more information about Oracle Sales Cloud, see Oracle Sales Cloud.

Configuring Basic Information Properties

You can enter a name and description on the Basic Info page of each source and target
adapter in your integration.

Topics
¢ What You Can Do from the Basic Info Page

e What You See on the Basic Info Page

What You Can Do from the Basic Info Page

You can specify the following values on the source or target Basic Info page. The Basic
Info page is the initial wizard page that is displayed whenever you drag an adapter to
the source or target area.

e Specify a meaningful name.

® Specify a description of the responsibilities.
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What You See on the Basic Info Page

The following table describes the key information on the Basic Info page.

Element Description

What do you want to call your endpoint? Provide a meaningful name so that others can
understand the connection. For example, if
you are creating a source Oracle RightNow
Cloud connection, you may want to name it
Ri ght Nowl nboundDi r ecti on. You can
include English alphabetic characters,
numbers, underscores, and dashes in the
name. You cannot include the following:
¢ Blank spaces (for example, My RightNow
Connection)

* Special characters (for example, #;83& or
righ(tynow4)

* Multibyte characters

What does this endpoint do? Enter an optional description of the
connection’s responsibilities. For example:
Thi s connection receives an
i nbound request to synchronize
account information with Oracle
Sal es C oud.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties

Enter the Oracle Cloud adapter configuration connectivity and Credential Store
Framework (CSF) key values for your integration.

Topics

* What You Can Do from the Oracle Cloud Adapter Connection Page
¢ What You See on the Oracle Cloud Adapter Connection Page

e What You Can Do from the Oracle Cloud Adapter CSF Key Page

¢ What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page

You can specify the following connection values for the Oracle Cloud adapter.

¢ Specify the WSDL URL for some adapters. If you are configuring the Oracle Eloqua
Cloud adapter, no WSDL is required.

¢ Specify the security policy.

* Create the authentication key. A key created for one direction (for example,
outbound) is also available for selection in the other direction (for example,
inbound).
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What You See on the Oracle Cloud Adapter Connection Page

The following table describes the key information on the Oracle Cloud adapter

Connection page.

Element

Description

WSDL URL

Note: This field is not displayed for the
Oracle Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to
build integrations specific to your instance.
You can also select the WSDL from a file
system or another source by choosing the
browser icon next to the WSDL URL field.
Click File System at the top of the dialog,
then browse for the WSDL.

Security Policy

Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

* The wizard shows all policies, including
those that may not be applicable. To make
a correct selection, you must have a
knowledge of policies. For example, you
cannot select a SAML-based policy
because the identity is not propagated.

¢ The policies you apply to the cloud
adapter are unique to the cloud adapter
and do not impact other endpoints in the
composite.

Authentication Key

Select the CSF authentication key.

* Add: Click to create a new authentication
key. You must specify the key name, user
name, and password. To successfully
deploy and administer your application,
you must specify these same values in
Oracle Enterprise Manager Fusion
Middleware Control.

¢ Edit: Click to edit an authentication key.

* Delete: Click to delete an authentication
key.

Test

Click to validate the authentication key.

What You Can Do from the Oracle Cloud Adapter CSF Key Page
You can specify the following CSF key values for the Oracle Cloud adapter.

* CSF key name

¢ Company name for the Oracle Eloqua Cloud adapter only

¢ User name and password
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What You See on the Oracle Cloud Adapter CSF Key Page

The following table describes the key information on the Oracle Cloud adapter CSF
Key page.

Element Description

CSF Key Name Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password
required for authentication with the
application (for example, the Oracle Sales
Cloud or Oracle HCM application). This key
identifies your login credentials during
design-time. To successfully deploy and
administer your application, you must
specify these same values in Oracle
Enterprise Manager Fusion Middleware
Control. For instructions, see the Oracle Cloud
Adapters Postinstallation Configuration Guide.

Company Name Note: This field is only displayed for the
Oracle Eloqua Cloud adapter.

Specify the Oracle Eloqua company name.

User Name Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle HCM application). Your
administrator provides you with user
credentials.

Password Enter the password for connecting to your
application.

Re-enter Password Re-enter the same password a second time.

Configuring Oracle Sales Cloud Source Request Properties

Enter the Oracle Sales Cloud connection source request values for your integration.
The values you specify start the integration.

Topics
e What You Can Do from the Oracle Sales Cloud Source Request Page

e What You See on the Oracle Sales Cloud Source Request Page

What You Can Do from the Oracle Sales Cloud Source Request Page

You can select the following source request values for the Oracle Sales Cloud
application.

Select the specific type to receive as a request from Oracle Sales Cloud:

® Select to receive a business object as a request from Oracle Sales Cloud. This
selection invokes the integration.
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What You See on the Oracle Sales Cloud Source Request Page

The following table describes the key information on the Oracle Sales Cloud adapter
source Request page.

Element Description

Select Business Object Select the business object from the Oracle
Sales Cloud application to receive as a
request that starts the integration.

Object Name Filter Type the initial letters of the name to filter the
display of business objects.

Configuring Oracle Sales Cloud Source Response Properties

Enter the Oracle Sales Cloud source response values for your integration.

Topics
e What You Can Do from the Oracle Sales Cloud Source Response Page

* What You See on the Oracle Sales Cloud Source Response Page

What You Can Do from the Oracle Sales Cloud Source Response Page

You can configure the operation and business object that comprise the response type
for Oracle Sales Cloud.

¢ Immediate (synchronous) response: A response business object is immediately
returned as output. You select Immediate as the response type on the Response
page and select the business object as part of the response to the client.

* No response is required: You deselect the Send checkbox on the Response page
because a response is not required.

What You See on the Oracle Sales Cloud Source Response Page

Select the business object for the integration to send as a response document to the
Oracle Sales Cloud application.

The following types of responses are available.
¢ Immediate: A synchronous response is required (See Table 5-1 for instructions)

* None: No response is required (See Table 5-2 for instructions)

The following table describes the fields available if an immediate (synchronous)
response is required.
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Table 5-1 Response Type — Immediate (Synchronous) Response is Required

Element

Description

Immediate Response

Select Immediate for the Oracle Sales Cloud
application to wait until a response is
received from the integration. This is also
known as the request and response message
exchange pattern. This is the default
selection.

Also Send faults

Select this checkbox if you want to send fault
information to the Oracle Sales Cloud
application if any errors are encountered by
the integration while processing the request.
This is an optional checkbox only available
with the Immediate response type.

Object Name Filter

Type the initial letters to filter the display of

business objects. You can also select a filter

type:

¢ AllL Displays all objects.

¢ Custom: Displays objects you created.
The naming convention is a combination
of the package name and object name
joined by a “. ”. For example, if there is a
custom object package called COand an
object named Pur chasePr oduct, the
wizard displays the custom object as
CO. Pur chasePr oduct .

¢ Standard: Displays business objects
delivered as part of the standard Oracle
Sales Cloud application.

Select Business Object

Select the business object to receive from the
Oracle Sales Cloud application as a response.
You can filter the display of business objects
by typing the initial letters of business objects
in the Object Name Filter field. A description
of the selected business object is displayed
below this list.

The following table describes the fields available if no response is required.

Table 5-2 None — No Response is Required

Element Description

Send Deselect if a response is not required. This
option disables the selection of business
objects because none are required.

Response Type If you deselect the Send checkbox, this

section is disabled.
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Element

Description

Select Business Object

If you deselect the Send checkbox, this
section is disabled.

Configuring Oracle Sales Cloud Target Operation Properties

Enter the Oracle Sales Cloud target operation values for your integration.

Topics

* What You Can Do from the Oracle Sales Cloud Target Operations Page

* What You See on the Oracle Sales Cloud Target Operations Page

What You Can Do from the Oracle Sales Cloud Target Operations Page

You can configure the following target operations values for Oracle Sales Cloud.

* Browse for and select a business object or service.

® Select the operation to perform on the business object or service.

What You See on the Oracle Sales Cloud Target Operations Page

The following table describes the key information on the Oracle Sales Cloud target

Operations page.

Element

Description

Browse by

Select to browse by business object or service.
There is a one-to-one correspondence
between the business object and service. The
service acts on the business document.

* Business Objects: Select to browse a list
of available business objects.

* Services: Select to browse a list of
available business services.

Object Filter Name

Type the initial letters to filter the display of
business objects.

Business Objects

Select the business object or service to use.

Select the operation to perform on the
business object or service

Select the operation to perform on the
selected business object or service.

Life Cycle Displays the state of the selected business
object or service. Deprecated indicates the
business document is nearing the end of use
and must be used with caution.

Description Displays a description of the selected

business object or service.
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Reviewing Configuration Values on the Summary Page

You can review the specified source or target adapter configuration values on the
Summary page.

Topics
e What You Can Do from the Summary Page

e What You See on the Summary Page

What You Can Do from the Summary Page
You can review source or target configuration details from the Summary page. The

Summary page is the final wizard page for each adapter after you have completed
your configuration.

* View the configuration details you defined for the source or target adapter. For
example, if you have defined an inbound Oracle RightNow Cloud source adapter
with a request business object and immediate response business object, specific
details about this configuration are displayed on the Summary page.

¢ Click Done if you want to save your configuration details.

* C(lick a specific tab in the left panel to update your configuration definitions.

What You See on the Summary Page

The following table describes the key information on the Summary page.

Element Description

Summary Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard. To return to a previous
page to update any values, click the
appropriate tab in the left panel.
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Managing Applications

This section describes how to manage and monitor an Oracle SOA Suite or Oracle
Service Bus application that uses the adapter from Oracle Enterprise Manager Fusion
Middleware Control or Oracle Service Bus Console.

Topics

* Managing the Application in Oracle Enterprise Manager Fusion Middleware
Control

e Testing Oracle Service Bus Projects from Oracle Service Bus Console

Managing the Application in Oracle Enterprise Manager Fusion
Middleware Control

You manage the SOA composite application or Oracle Service Bus business service
that includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1. Login to Oracle Enterprise Manager Fusion Middleware Control.

2. In the navigator, expand the tree to display your SOA composite application or
Oracle Service Bus business service project (for this example, a SOA composite
application is selected).

3. Select the SOA composite application.
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4. Click Test.

The Test Web Service page is displayed.
5. Complete the fields on the page to initiate a test of your composite.
6. Click Test Web Service.

Invocation results are displayed.

7. Click Launch Flow Trace to view the flow trace of the SOA composite application,
including flow details about the adapter.

For more information about monitoring applications from Oracle Enterprise
Manager Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle
Business Process Management Suite and Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service Bus
Console

You can test Oracle Service Bus business service projects from Oracle Service Bus
Console.

1. Log in to Oracle Service Bus Console.

2. In the navigator under All Projects, open the project to test.
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3. In the navigator, click the business service for that project.

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint.
This opens a window that displays the proxy service and the operation to test.

5. Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed
under the Response Document section.

For more information about testing Oracle Service Bus business service projects,
see Administering Oracle Service Bus.
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